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Abstract

Intraepidermal nerve fibers (IENFs) are thin, unmyelinated nerve fibers that extend from the dermis into the
epidermis. Consisting mostly of C-fibers and some Aé-fibers, these fibers are involved in sensory transduction
processes, including pain (nociception), thermosensation, and itch. Due to these roles, IENFs are among the
first nerve fibers to degenerate in peripheral neuropathies, contributing to conditions like mechanical allodynia
and thermal hyperalgesia. As a result, IENFs serve as an early biomarker for nerve damage in conditions like
diabetes, chemotherapy-induced neuropathy, and autoimmune diseases.

This protocol provides a detailed, step-by-step guide for the processing, staining, and quantification of
intraepidermal nerve fiber density (IENFD) in mice. Using an immunohistochemical (IHC) approach, IENFs will
be labeled with PGP 9.5, a pan-neuronal marker, and subsequently imaged via confocal microscopy for
analysis.

The expected results include clear visualization and quantification of IENFs, allowing for the assessment of
nerve fiber density in different experimental conditions. This method enables the detection of neuropathy-
associated fiber loss and provides insight into potential neuroprotective or regenerative effects of treatments.

Image Attribution

Images were created in BioRender
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Materials
Chemicak

Chemical Name Brand Product # Lot#
0.1 MPES (pH 7.4) | Gibco 10010031 2363310
BSA Powder Sigma A2133 SLCHO03%6
Triton x-100 Fizher Scientific BP1il 110012
Tizzue Plus OCT  |Ficher Healthcars 4383 4373
Compound
PFA 16% wivsoln |Thermo Scientific (04336890 NI6KD30
30% Sucrose Sigma Aldrich 89378 308120
Invitrogen Prolong | ThermoFisher P36931 2841592
Gold + DAFI Scientific
Primary Antibody | Cedarlane CL7736 2436238
(Affinity Purified
F.abbit Anti-human
PGP 9.3)
Secondary Antibody | ThermoFisher A11001 1939600
(Invitrogen Alexa- |Scientific
Fluor 438 Goat Anti-
Mibuze)
DAPI Thermo Scientific  |62248 VE3126282
Sodivm Citrate Sigma Aldrich W 302600 MECF6319
Dihydrate
TWEEN 20 Sigma Aldrich P1379 SLER9241V
Other Chemic als
Deionized Water  |Ethanol [DryIce
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Materials

R emoval of the Hind Paw
Scizsors 1.5 mL 4=C

McroCentrifuge Refrigerator

Tube
Preparation of the Tissue for Slicing
Ice Bucket |Ha.m.msf |3‘d.=:tal Pan |
Dissection of the Foot Pads
Tweszers No. 3 Scalpsl Ne. 10 Lancets |OCT Iviold Boxes
Mietal Pan (2+in  |Ice Buckst - 80°C Freezer
deep)
Slicing the OCT Molds
Leica CWB050= Ice Buckst 12zl Plate  |OCT Stands
Crvostat
Single-Edge Fazor | Thick-Combed Tweszers

Paintbrush
Staining the Paw Sections
VWE p-20 Gilzon p-1000 hcrowave Biomega Hotplate
Mbcropipette with  |MEcropipette with Stirrer

Correspondine Tips |Corresponding Tips

ThermoScientific  |Fisher Brand Plate  |Aluminum Foil (4°C Refrigerator
Heat Block Eotator

Various Glazsware |VWE Model 164AC
for Preparation of  |Balance

Solutions
Mounting the Sections on Slides
10 cm PetriDish | Mbcroscope Slides  |Glass Cover  [Gilson p-1000

Slips Micropipettz with
Cotresponding Tige

10/0 Fine-Tipped  (VWER p-20
Paintbrush Mcropipette with
Corresponding Tips

Troubleshooting

Before start

We, the researchers, utilized a FisherBrand Plate rotator (speed set to 12) in any step that required washing or
placement of solution (e.g., reagents, solutions, antibodies). While it is not a required feature of this protocol or
other IENF density protocols, we highly recommend it to ensure full and even saturation of the tissues.
Additionally, all wash steps were completed with 0.1 M PBS (pH 7.4). Fiji, a distribution of ImageJ, was used to
process confocal images for the quantification of IENFs.
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Removal of the Hind Paw

1

Before removing the hind paw of the mouse, ensure that you have properly euthanized

the mouse, according to IACUC-approved guidelines. Once death has been ensured, use

a sharp pair of scissors and remove the entire hind paw at the base of the ankle bone.

Note

When removing hind paws, | tend to alternate between the left and right hind paws of
subsequent mice.

To fix the tissue, place the hind paw in a 1.5 mL microcentrifuge tube (or any 1.5 mL
tissue tube) containing a cooled 4% PFA solution and put into a 4°C refrigerator
overnight.

Note

Ensure you use enough PFA to fully submerge the hind paw.

To sucrose imbed the tissue, remove the hind paw from the PFA solution and wash it in
0.1 M PBS before placing it in a 1.5 mL tissue tube containing 30% sucrose solution.
Place tubes in a 4°C refrigerator and wait until tissues have completely sunk to the
bottom of the tissue tube before beginning the staining process. Once this occurs, you
are ready to prepare the hind paw for slicing.

Note

The sinking of the tissues generally takes 2-3 days.

Preparation for Tissue Slicing

4

Remove the sucrose-imbedded tissues from the refrigerator and place tissue tubes in an

ice bucket. You are now going to prepare your work bench to flash freeze your hind
paws in OCT.

Acquire a bucket of dry ice and use a hammer (or any tool capable of crushing) to smash

the dry ice into fine, snow-like particles.
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6 Put half of this dry ice into a metal pan that is at least 2 inches deep and leave the
remainder in the ice bucket.

7 The metal pan will serve as the flash-freezing reservoir for these tissues. In order to
activate this reservoir, you must add ethanol to the metal pan containing the dry ice.

Safety information

Be careful not to pour the ethanol too fast for it might cause the dry ice to jump out of the
pan and burn you.

8 You will now need to remove the hind paws from the sucrose solution and wash them in |=‘«
01 M PBS.

9 The following steps will walk you through dissection of the foot pads from the paws. This
part of the protocol has been slightly modified from another protocol cited in my
references.

Dissection of the Foot Pads

10
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Overview of paw dissection. You will position the paw face-up towards the ceiling (A) and
use a scalpel or razor to remove the digits (B). You will then use the scalpel on the digit-
less foot pad (C) to carefully cut the top layer off (D). When you have removed the top
layer (E), put it into an OCT mold (F) and commence the flash-freezing process. Figure
made on Biorender.com

Once the paw has been washed, remove it from the PBS and put it on a hard surface.
You will need to use a pair of tweezers to hold the paw firmly in place (i.e., by the base of
the ankle bone). Using a No. 3 scalpel with an attached No. 10 lancet, remove the toes of
the paw at their respective joints, ensuring that you leave the paw pads intact, as shown
in parts A-C of the figure .

Starting from the heel of the paw, gently use the scapel to remove the entire plantar
surface of the paw, as shown in parts D and E in the figure. Ensure you are gentle with
the tissue to mitigate potential damage.

Now that you have cut your tissue, you will need to place them in OCT molds. Ensure that
all of your molds are oriented in the same direction to prevent any errors in slicing later.
Gently place the plantar surfaces of the paw in a layer of OCT, with the external side
facing up and the internal side facing down, as shown in part F of the figure. Additionally,
ensure that the tissue is oriented toward the side of the mold of which you plan to begin
your slicing. Add another layer of OCT on top of the tissue to fully encase it.
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13.1

14

15

16

Using a fine pair of tweezers, move any bubbles that present themselves in the mold
away from the tissue sample. You can also use these at this step to fine-tune the position
of the tissue to make sure that it is in the middle of the mold and is parallel to the bottom
of the mold.

Set the OCT molds containing tissues in the pan containing the ethanol and dry ice. You
will notice that the OCT surrounding the tissue will begin to change from clear to white,
starting from the bottom.

When the mold has turned completely white, remove it from the pan and place it in the
ice bucket with the remaining crushed dry ice. Follow steps 10-14 for the remaining
paws.

Deposit your OCT molds in a minus 80°C-safe box and store them in the freezer until you O
are ready to slice and stain.

Slicing the OCT Molds

17

18

19

20

21

22

Prior to slicing, ensure that: §
1) Your cryostat is turned on and set to -20°C.

2) You place the OCT stands in a bucket of crushed dry ice to cool in preparation for

attachment of the molds.

3) You prepare a 12-well plate containing ~1000 uL of PBS in each well.

Retrieve your molds from the -80°C freezer. You will now mount your OCT molds to OCT
stands. Using a single-edge razor, slice the mold casing off of the OCT block to remove
it. For more efficient slicing, also remove any excess OCT surrounding the mold.

Add a dollop of OCT to the bottom of the mold and press it firmly to the cooled OCT
stand. Once the mold has adhered to the stand, encase the bottom of the mold with
additional OCT to ensure that it does not fall off during the slicing process.

Once all molds have properly adhered to their stands, place them in the cryostat for 30 30m
minutes. This will allow the molds to acclimate to the cryostat's temperature.

Mount the first OCT stand in the cryostat. Beginning at 100 um, slice the OCT block until
you begin to see the top of the plantar surface. Remove shavings with a thick-combed
paint brush.

Change slice size to 30 um and slice 15-30 slices, gently picking up the slices with fine
pointed tweezers and placing them in their respective well of the 12-well plate.
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23

Repeat steps 16-22 until you have sliced all of your paws.

Staining the Paw Sections

24

25

26

27

28

29

30

Now that you have all of your slices in their respective wells, you can begin the staining
process. Start by rinsing the tissue in PBS 3x for 5 minutes each. This will ensure that
there is no remaining OCT residue.

In the event that you do not start the staining procedure right away, remove the PBS from
the wells after all slices have been collected and add 500 uL of cryopreservative solution

to each well, then store your plate in a 4°C refrigerator.

Permeabilization Step:
Incubate tissues with 0.3% Triton x-100 solution (~500 uL/well) for 20 minutes, then
remove the solution from the well.

Note

No washing is required after this step.

Antigen Retrieval:

1) Boil the citrate buffer in a microwave or on a hot plate.

2) Add 500 pL of the warmed citrate buffer to each well.

3) Wrap your 12-well plate in aluminum foil and place it on a heating block set at 95°C
for 20 minutes.

Remove the plate from the heating block and allow it to cool to room temperature (~ 20

minutes).

Once the plate has had time to cool, remove the citrate buffer from each well and rinse
the tissues 3 times for 5 minutes each with PBS.

Blocking Step:
Add 500 pL of 5% BSA into each well and incubate for 2 hours.

Primary Antibody Incubation
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31 Primary Antibody:
1) Prepare the primary antibody solution using a dilution factor of 1:500 of the PGP 9.5
antibody in 1% BSA solution in 0.3% Triton x-100 solution.
2) Remove the 5% BSA from the wells and pipette 500 uL of the primary antibody
solution in each well and allow to incubate overnight in a 4°C refrigerator

Secondary Antibody Incubation

32  Secondary Antibody:
1) Prepare the secondary antibody solution using a dilution factor of 1:1000 of the Alexa
Fluor 488 antibody in 1% BSA solution in 0.3% Triton x-100 solution.
2) Remove the primary antibody solution and rinse tissues 3 times for 5 minutes each
with PBS.
3) Pipette 500 L of the secondary antibody solution in each well and allow them to
incubate for 2 hours.

33  DAPI Staining:
1) Prepare the DAPI solution using a dilution factor of 1:1000 of DAPI in PBS.
2) Rinse tissues 3 times for 5 minutes each and pipette 500 uL of DAPI solution in each
well for 5 minutes. Tissues will be ready to mount after this.

Mounting the Sections on Slides

34 Fill a 10 cm petri dish with PBS.
35  Submerge a microscope slide 1/2 to 1/3 of the way into the dish with the dry side leaning

on the rim of the dish.

36 Using a P-1000, transfer the slices from the well that you are beginning with and gently
deposit them on top of the submerged slide.

Note

You can cut the end off of the P-1000 pipette tip to avoid tearing the slices.

37 Using a 10/0 fine-tipped paintbrush, gently move each slice onto the slide and adjust
their position in a manner that is best for your personal microscope setup.
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38

39

40

41

42

43

When you have oriented all slices onto the slide, remove the slide from the PBS and lay it
out of the light to dry.

Note

We have been mounting a total of 8 slices per paw. Two total slides with four slices per
slide.

Repeat steps 36-39 until all slices are mounted onto the slides.

When slices have completely dried on the slides, you will now mount coverslips with
ProLong Gold antifade reagent with DAPI.

Choose the side of the slide that you will begin from (e.g., left-most or right-most). Add a
drop of ProLong gold (~10 uL) to the side of your first tissue.

Acquire your cover slip and position it at a 45° angle adjacent to where you put the
ProLong gold.

Very gently move your cover slip down towards the slide and allow the slip to spread the
ProLong gold evenly across all slices.

Note

Be careful not to drop the cover slip too fast for it might cause bubbles. Additionally, if you
don't allow the slices to properly dry and if you 1) add too much ProLong and/or 2) drop
the coverslip too fast, this can cause the slices to move out of position and introduce
bubbles to the slide.

Allow the slides to dry for 24 hours before you begin to image.

Confocal Microscopy Imaging of IENFs

44

Microscope Setup

= Turn on the Leica SP8X confocal microscope and allow the system to initialize.

= Set the Fluo Turret to Scan-BF mode for imaging.

= Ensure that the HC PL APO CS2 40x/1.10 water objective lens is selected and properly
immersed in water.
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441

44 .2

44 .3

44 4

Image Acquisition Settings

= Set the image resolution to 512 x 512 pixels.
= Adjust the scan speed to 400 Hz.
= Configure averaging and accumulation settings:

= Line averaging: 2

= Line accumulation: 1

= Frame averaging: 1

= Frame accumulation: 1

Z-Stack Acquisition
= Enable Z-stack acquisition mode.
= Set the Z-wide mode with a Z-step size of 0.32 um for optimal sectioning

Laser Configuration

Configure the laser settings as follows:
= 405 nm diode laser
= White Light Laser (WLL) for fluorophore excitation

Imaging Execution

= Adjust exposure and gain settings as necessary for optimal signal detection.
= Capture images with the specified settings, ensuring proper focus and clarity.

= Save images in the desired format for subsequent IENFD quantification.

Image Processing in Imaged Software

45

451

Basement Membrane Length

= Open Imaged

= |nsert 2D Tiff files

Process all Tiff files

= Split Channels: Image > Color > Split Channels

= |nvert Tiff: Edit > Invert
= Close out of all channels but the (blue) wavelength channel
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45.2 Set Measurement

1. Analyze > Set Scale
= Check Global Scale box
= Click to Remove Scale

Note

The global removal of scale is done to ensure that no previous scale is being applied to
the images.

1. Select straight line tool

2. Trace over scale bar on image or if you know the total x or y length of the image in
microns you can trace the entire length of the image

3. Push the M key on your keyboard to get the length of pixels.

4. Set Scale:

» distance in pixels: The length of the previously measured scale bar or x/y distance of
image

= Known distance: Length of the scale bar in microns

= Pixel aspect ratio: 1.0

= Unit of length: um

= Ensure Global is checked

= Press "Ok"

46 Tracing the Basement Membrane
Now that you only have the blue (DAPI) wavelength image visible, do the following:

1. Select the Freehand line

2. Trace the bottom of the basement membrane, as described below

3. Press "M" to record the length

4. Close out of each image and repeated 1-3 for each subsequent image

1. Identifying the BM

» The basement membrane (BM) is the boundary separating the epidermis and dermis.

= [t appears as a thin, distinct interface between the densely packed keratinocytes of
the epidermis and the less dense, more fibrous dermal layer.
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2. Locating the Correct Tracing Position

= To accurately trace the BM, focus on the bottom edge of the BM, which is closer to
the dermal layer.

= Look for a visible separation between: The tightly packed keratinocytes in the lower
epidermis. The sparser, more fibrous appearance of the underlying dermis.

3. Step-by-Step Tracing Method

1. Zoom in to enhance visibility of the BM structure.

2. Identify a consistent reference point where the epidermis and dermis separate.

3. Follow the lower edge of this boundary, ensuring the traced line remains just above
the dermis but does not extend into epidermal layers.

4. Maintain a smooth, continuous tracing, avoiding jagged or inconsistent movements.

5. If needed, adjust contrast to enhance BM visibility.

Image without any tracing.
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Image with the BM outlined using the Freehand Line Tool

Quantification of IENFs

47  Preparing the DAPI Channel for BM Tracing

1. Open the image in ImagedJ/Fiji or appropriate imaging software.

2. Select the blue (DAPI) wavelength channel (which stains nuclei and helps visualize
the epidermal-dermal boundary).

3. Adjust the contrast and brightness to enhance the visualization of the keratinocyte
nuclei, ensuring the BM is clearly distinguishable.

4. Locate the epidermal-dermal junction by identifying the transition between the
densely packed basal keratinocytes and the sparser dermal layer.
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5. Manually trace the BM along this transition using the freehand or segmented line tool,
ensuring a continuous and smooth path.

6. Save the traced BM as a separate overlay or ROI (Region of Interest) for use in the
next step.

Overlaying the BM Trace onto the Green Wavelength Channel

1. Switch to the green channel, which contains the PGP 9.5-labeled IENFs.

2. Invert the green channel for better fiber visibility:

= |n ImageJ/Fiji, go to Image — Adjust — Invert LUT.

3. Adjust brightness and contrast to optimize nerve fiber visualization:

= |ncrease brightness to enhance faint fibers.

= Adjust contrast to reduce background noise while maintaining fiber integrity.

Applying the BM Trace to the Green Wavelength Channel

=

. Overlay the BM trace onto the green channel:
If using ImageJ/Fiji, use ROl Manager to load the previously traced BM.
Apply the BM trace to the green channel using "Add Selection" or "Overlay" functions.

1. Ensure that the BM trace correctly aligns with the epidermal-dermal junction in the

green channel.
2. Save the final composite image for IENFD quantification.
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Inverted green channel with the BM (outlined in yellow) overlayed on top.

Scoring and Quantification of IENFs

48 Image Processing and Preparation for Scoring

After processing all images and overlaying the basement membrane (BM), the finalized
images were saved and compiled into a PowerPoint presentation for scorers, who were
blinded to the treatment groups, to generate their counts. The scoring process followed
standardized guidelines adapted from The European Federation of Neurological
Societies (EFNS) to ensure consistency and accuracy in IENF quantification.

Counting Criteria for IENFs

Scoring was performed based on the following guidelines:

protocols.io | https://dx.doi.org/10.17504/protocols.io.j8nlk8n95I5r/v1 April 14, 2025 17/20


https://www.protocols.io/
https://www.protocols.io/
https://dx.doi.org/10.17504/protocols.io.j8nlk8n95l5r/v1

€3} protocols.io Partof SPRINGERNATURE

. Nerve fibers were counted as they crossed the BM into the epidermis.
. Any fiber that branches at the BM and enters the epidermis (stratum spinosum) was

counted as a separate unit.

. If a nerve fiber split below the BM before entering the epidermis, each branch was

counted as an independent fiber.

. Nerve fragments that crossed the BM and extended beyond a single layer of basal

keratinocytes were included in the count.

. Fibers that approached the BM but did not cross into the basal keratinocyte layer

were excluded from the count.

. In regions where the BM shifted across different focal planes, only epidermal fibers

with a continuous connection to dermal axons were counted.

. Epidermal axons that lacked a direct connection to dermal axons were excluded from

the analysis.

Analyzing IENFD

49

Once you have the numer of IENFs and the BM length (convert from microns to mm), you
can calculate IENFD. Simply divide the # of fibers/BM length(mm).
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Left: Image not processed in Imaged. Right: Yellow line represents the basement
membrane. Black arrows point to IENFs that are crossing the basement membrane.
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Combined

Vehicle

Combined

Cisplatin

Combined

Duloxetine

CBC
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